
General Information about CyberKit

CyberKit copyright 1996-1998 by Luc Neijens all rights reserved.

CyberKit requires Windows 95/98 or Windows NT.

CyberKit also requires a working TCP/IP connection to a local network or the Internet.

To use ping and traceroute, you will need Microsoft winsock 2.0 or higher installed. It is possible to use a 
non-Microsoft winsock stack if this stack supports raw sockets. Windows 98 and Windows NT already 
ship with the winsock 2 stack. Windows 95 users can download an upgrade from the Microsoft site. 
Microsoft has no upgrade available for Windows NT 3.51.
You can use the Winsock Information item on the View menu to verify whether your winsock stack is 
compatible with CyberKit. You will need support for raw sockets and setsockopt() as you can see on the 2
bottom lines in the picture below.

Microsoft, Windows 95 and Windows NT are registered trademarks or trademarks of Microsoft Corporation.    Other trademarks are 
the property of their respective owners.



Privacy Issues

With the Internet and the growing interconnectivity between computers, privacy has become a hot issue. 
Rumors about applications taking a snapshot of what is installed on your computer and then sending that 
information over the net to the manufacturer (without your knowledge) are at the least disturbing. 

I can assure you CyberKit does not send any information whatsoever over the line except for what is 
absolutely necessary to perform the requested function.
For example, when CyberKit is checking for new mail, it has to log on to your POP account. This includes 
sending user id and password over the line. I think it is clear that this can not be avoided. Your e-mail 
client will have to do the same. Just be aware that this is happening and change your password 
frequently! The password is kept in the registry on your computer. It is encrypted, but I'm not a 
cryptographer, so I can assure you that if someone with bad intentions has access to it, he will be able to 
decipher your password (even if I was a cryptographer, given enough time and computer power, any code
can be broken!).



Copyright Information and Disclaimer

CyberKit is NOT Public Domain software.

CyberKit is postcardware. So if you like it, send me a postcard. Preferably one that has something to do 
with where you live.

Please send the postcard to the following address:
Luc Neijens
Berkenlaan 8
3960 BREE
Belgium

Distribution and Restrictions
You are free to distribute CyberKit. Any such distribution must be limited to the original and unchanged 
archive.
You are allowed to include CyberKit on a cover CD-ROM for a book or magazine, but only if you are 
willing to send me a copy of this book or magazine to the above address.
You are NOT allowed to make any changes to CyberKit and you are NOT allowed to charge for 
distribution. You may NOT reverse engineer, decompile, or disassemble CyberKit.
If you have any doubts as to whether your actions are allowed, they probably aren’t and you MUST check
with me first!

DISCLAIMER
THE INFORMATION AND CODE PROVIDED IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED. IN NO EVENT SHALL LUC NEIJENS BE LIABLE FOR ANY 
DAMAGES WHATSOEVER INCLUDING DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, LOSS 
OF BUSINESS PROFITS OR SPECIAL DAMAGES, EVEN IF THE AUTHOR HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES.
DO NOT USE CYBERKIT UNLESS YOU CAN FULLY AGREE WITH THIS DISCLAIMER.

CyberKit, copyright 1996-1998 by Luc Neijens. All rights reserved.



Getting Started with CyberKit

First, you need to understand the difference between a host name and a host address:
A host address or TCP/IP address    consists of 4 numbers between 0 and 255 seperated by a period. For 
example, 120.56.98.45 would be a valid TCP/IP address. Every computer on the Internet (or any other 
TCP/IP network), including your PC, has a unique TCP/IP address. So, in order for your computer to be 
able to connect to any other computer on the Internet, it has to find out the TCP/IP address of that 
computer.

Now, how does my computer find the TCP/IP address of that FTP server, or that site I’m surfing to on the 
world wide web?
Well you are giving it to your computer! Of course you rarely enter a TCP/IP address, usually you just 
enter something like www.host.com, also known as a host name. Your computer then uses this host name
to find out the TCP/IP address. This process is called ‘resolving’ a host name.
How does this work?
First, your computer will look in your hosts file. The hosts file is located on your computer and it is a 
simple text file that looks something like this:

127.0.0.1 localhost
120.56.98.45 www.host.com
etc.

If this hosts file is not present, or it does not contain the host name we are looking for, your computer will 
connect to a DNS (Domain Name Server) server and try to resolve the host name there. Which DNS 
server your computer will connect to is specified in the TCP/IP settings of your computer.
The DNS server is in fact nothing more but a list of host names and the matching TCP/IP addresses.

So what does al this have to do with CyberKit?
Most functions in CyberKit will require a TCP/IP address or a host name. If you enter a host name, 
CyberKit will find out the TCP/IP address if needed and vice versa.
CyberKit contains functions like ping and traceroute, that enable you to verify whether a server is online 
and which route a TCP/IP message takes to reach that server. There is also a function called nameserver 
lookup, that you can use to resolve a host name into a TCP/IP address or resolve a TCP/IP address into a
host name.



Shortcut Keys in CyberKit

You can use the ENTER key as a shortcut for the GO button, and the ESC key as a shortcut for the STOP
button. CTRL-TAB switches to the next tab, CTRL-SHIFT-TAB switches to the previous tab. Whenever 
there is a button or text field with a underlined letter, you can press ALT-<underlined letter> as a shortcut 
key for that button or for selecting that text field.
Some examples:
- ALT-g is a shortcut for the GO button
- ALT-a, in most functions, is a shortcut for jumping to the ‘host or address’ field.
- ALT-v (shortcut for the view menu) followed by ALT-w (shortcut for the winsock information item in the 

view menu) shows you the winsock information dialog.
- ALT-F4 terminates CyberKit
- F1 shows the help file
- F9 shows the options dialog
- F10 shows the output font dialog
- F12 shows the address book

Cyberkit also supports the standard shortcut keys of the edit boxes:
Use CTRL-C to copy text to the clipboard, CTRL-V to paste text from the clipboard, CTRL-X to cut text to 
the clipboard. CTRL-Z will undo your last action in the edit box.



Postcardware

Postcardware is almost freeware. If you try out a postcardware program, and decide that you’d like to use
it on a regular basis, you then just send a postcard to the development team or programmer.



Lights

 3 lights
Just above the ‘Go’ button you can see 3 lights.
The first indicates that one of the functions: ping, traceroute, finger, whois, name server lookup or quote of
the day is active. The second is used by the Keep Alive function and the last is used by the Check For 
New Mail function.
A green light indicates the function is active, a red light indicates something went wrong. You can use the 
‘Create a trace file’ option for the Keep Alive or Mail function to track down the problem.



Installing/Un-Installing CyberKit

Installing CyberKit
- Unzip the archive in a temporary directory.
- Click on the Start button on the Taskbar.
- Click on the Start menu's "Run" selection.
- Type the path to the unzipped files followed by "\SETUP.EXE".
- Click on the "OK" button.
- Follow the on-screen prompts to complete the installation.
Or if you’re using WinZip: Just open the archive and select ‘Install’.

CyberKit copies all its files to the CyberKit directory. It does not copy any files to other directories like the 
windows or system directory.

Registry Settings:
Disclaimer: With the registry editor (Windows 95 uses regedit.exe and Windows NT uses regedt32.exe) 
you can do devastating damage to your operating system. Use with EXTREME care!
CyberKit keeps user setting in the windows registry under the following key:
HKEY_CURRENT_USER/Software/Luc Neijens/CyberKit
The key CyberKit and its contents will be removed when you uninstall CyberKit.
If at any time these settings are corrupted, you can safely delete the complete CyberKit key. CyberKit will 
create this key at startup if not present. However, you will lose your personal settings if you do this!
 
Uninstalling CyberKit
- Open the control panel.
- Double click on the ‘Add/Remove Programs’ icon.
- You will see a list of installed software, select CyberKit on the list.
- Click on the “Add/Remove” button.
- Follow the on-screen prompts to complete the uninstallation.



FAQ (Frequently Asked Questions)

Where can I find more ‘Quote of the Day’ servers?
You can try www.engen.com. The Quote service is supported by most NT servers, so this might be a 
place to start your search. Feel free to report other servers, so I can include them here and in the default 
address book.

How can I configure CyberKit to use Microsoft    Internet Mail as my E-Mail reader?
Go to the mail pptions dialog and specify the following as your E-Mail Program: "C:\WINDOWS\
EXPLORER.EXE" /root,C:\WINDOWS\Internet Mail.{89292102-4755-11cf-9DC2-00AA006C2B84}

How can I ping myself?
You can always ping your own computer by using the address 127.0.0.1. As a shortcut you can use ‘me’ 
or ‘myself’ as host name. You might also consider adding the line ‘127.0.0.1 localhost’ to your hosts file.

How can I start CyberKit minimized in the tray?
Use the /M command line parameter, and set the ‘Minimize To Tray’ option in the general options dialog. 
Do NOT use the Windows ‘run minimized’ option!

How do I install CyberKit?
Refer to the Install/Un-Install section for instructions.

How do I uninstall CyberKit?
Refer to the Install/Uninstall section for instructions.

How do I know if a host supports finger, whois or any other service?
Most of the time will Winsock return a specific error if a host does not support a service. If you try to 
connect to a host and you get the Winsock error 10061 (Connection refused), you can safely assume that
the service is not supported by that host.
In the whois section is explained how you can get a list of recent whois servers.

How do I report a problem?
See the problem reports section for instructions.

What do I need to use CyberKit?
See the discussion in the about section

What is the difference between finger and whois?
Not much!
Whois tends to give you more in-depth data. With whois you are connecting to a NIC server. Whois will 
only provide the information which is registered at the NIC server.
With finger most of the time you are connecting to the provider of the user you are fingering. Finger can 
provide you with the log in information of users that are currently logged on to the system.

Where can I get the Winsock 2 stack?
There is an upgrade available for Windows 95 on the Microsoft site: 
http://www.microsoft.com/windows95/info/system-updates.htm. Windows NT 4.0 already ships with the 
new winsock stack, as will Windows 98. Microsoft did not release an update for Windows NT 3.51.

Where can I get the latest release of CyberKit?
You can download the latest release of CyberKit from the CyberKit homepage: 
http://www.ping.be/cyberkit.

Why are the ping and the traceroute pages ‘grayed’ out?
See the trouble shooting section.



Related topics: Tips and Tricks, Trouble Shooting, Problem Reports



Tips and Tricks

Adding an address to the address book
If you open the address book it will initialize the ‘new host’ field with the contents of the ‘host’ and ‘query’
field of the active function. This way you only have to click ‘Add’ to add the last used address to the 
address book.

Adding CyberKit to the startup menu
If you want to start CyberKit every time you start your computer, here’s how you do it:
- Click on the Start button on the Taskbar
- Select ‘Settings’ and next ‘Taskbar’
- Select ‘Start Menu Programs’
- Select ‘Add’
- Select ‘Browse’ and locate CyberKit.exe, next select ‘Open’
- You will see something like ‘C:\CyberKit\CyberKit.exe’ (this can differ depending on the directory you 

installed CyberKit in). Add -M to the end of the line. You will have something like ‘C:\CyberKit\
CyberKit.exe -M’. This will make sure CyberKit starts minimized in the Tray.

- Select ‘Next’
- Locate and select the ‘StartUp’ folder
- Select ‘Next’
- Change the name for the shortcut to ‘CyberKit’
- Select ‘Finish’

Context sensitive help
CyberKit has context sensitive help. This means that if you press F1 from within for example traceroute, 
you’ll get help about ‘TraceRoute’.

Entering query and host name
If you have the option ‘Smart Address Splitting’ selected, you don’t have to enter query and host name 
separately. Just enter (or paste from the clipboard) an e-mail address and let CyberKit do the splitting for 
you. ‘Smart Address Splitting’ can also filter the host name out of an url (http://…) or ftp (ftp://…) address.

Help function for whois servers
Most whois servers have a help function. Just enter help as query and the server will return help 
information.

Getting a list of users that are logged on to a system
Most finger servers return a list of users that are logged on if you leave the query field blank.

Obtaining a recent list of whois servers
To get a recent list of whois servers, use 'sipb.mit.edu' for host name and ‘whois-servers’ as query. You 
will also find this address in the default addressbook that comes with CyberKit.

Remember Last Function
You can let CyberKit remember the last used function by checking the ‘Remember Last Function’ field in 
the general options dialog. If you now start CyberKit, it will automatically switch to the last used function 
(ping, finger, whatever).

Remember Last Window Position
You can let CyberKit remember its window size and position by checking the ‘Remember Window 
Position’ field in the general options dialog. If you now start CyberKit, it will start at its last screen location 
(minimized, maximized, whatever).

Smart address splitting
Make your life easy and let CyberKit split the addresses for you. This way you can simply paste an e-mail 



address in the host or query field and CyberKit will split it up for you. Try it, you’ll like it!
You can set the ‘Smart address splitting’ option in the general options dialog.

Using non-proportional fonts
The query output will look nicer if you use a non proportional font like courier or terminal. You can change 
the font from the options menu.

Related topics: Trouble Shooting, FAQ (Frequently Asked Questions), Problem Reports



Trouble Shooting

10061 (Connection refused) messages
These messages usually indicate that the server does not support the requested service.

Other Winsock error messages
I have tried to make the Winsock error messages as comprehensive as possible. The most common error
messages include some information about the possible reason for the error. Most common errors are 
caused by using an invalid host name or host address, a host that is down, etc.

Firewall issues
If you’re behind a firewall you may not be able to use CyberKit. This is not a problem of CyberKit, but a 
property of firewalls. Your network manager should be able to answer your questions. I know it is possible
to configure a firewall to use finger or whois (don’t ask me how because I don’t have any experience with 
it). However your network manager may choose not to do so because of security regulations.

Ping and traceroute tabs are grayed out / Winsock issues
Ping and traceroute require some of the Winsock 2 features. Winsock 2 already ships with Windows NT 
4.0 and Windows 98. You can download an upgrade for Windows 95 from the Microsoft site. Microsoft 
has no upgrade for Windows NT 3.51. If you are running a lower version (Windows 95 comes with the 1.1
release) or a non-Microsoft winsock stack that does not support raw sockets, these two pages will be 
‘grayed’ out. See also general information about CyberKit.

Time is displaying incorrect ‘Local Time’ / Synchronize Time is not working correctly
You must ensure your Control Panel’s Date/Time applet accurately reflects both your timezone and your 
daylight savings time. CyberKit relies on these settings to retrieve the current system clock in GMT 
adjusted format.
If you have a TZ variable set in your autoexec.bat file make sure it is defined accurately. In fact, unless 
there is a clear need for this variable, it is best to remove it outright and let the Control Panel settings 
handle the timezone.

Other problem?
Most questions/problems can be solved by reading the help file first. I’ve put a lot of effort in it, so please 
use it! I can assure you that answering the same questions day after day, while I know the answer is in 
the help file, is pretty frustrating. Read the Tips and Tricks and the FAQ (Frequently Asked Questions) 
sections first, next try to do a find on a keyword.
Ask yourself whether I’m the right person to answer your question. If your question is not specifically 
linked to using CyberKit, use the Internet! There are plenty information sources out there about 
programming, networking, sockets, TCP/IP, etc. with more information than I can possible provide.
You can reach me by e-mail at the following address: Luc.Neijens@ping.be.

Related topics: Tips and Tricks, FAQ (Frequently Asked Questions), Problem Reports



Problem Reports

Before reporting a problem
- If you have a problem with a beta, make sure you’re running the latest beta.
- Read the help file, especially the Tips and Tricks, the FAQ (Frequently Asked Questions) and the trouble

shooting sections.
- Visit the CyberKit homepage (http://www.ping.be/cyberkit) and make sure your problem is not already 

reported.

The information I need
- What OS are your running and what version: Windows 95, Windows NT 3.51/4.0?
- What winsock stack are you using (use the Winsock Information item on the view menu to find out)?
- Describe in detail what you did, what function you were using, what input you provided (addresses, host 

name, options).
- Note down in detail any messages (statusbar, dialog, etc.) you got from CyberKit.
- Can you reproduce the problem? If yes, please provide a detailed description on how to reproduce it.
- Are you willing to provide additional information if needed?
- Any other information you think may be relevant.

Please do not send me large attachments unless I specifically ask for them!

Send this information by e-mail to: Luc.Neijens@ping.be.

Related topics: Trouble Shooting, Tips and Tricks, FAQ (Frequently Asked Questions)



New Releases

The latest release can always be downloaded from the CyberKit homepage (http://www.ping.be/cyberkit).

Beta releases
Beta releases are intermediate releases. They have not been fully tested and are likely to contain bugs. If 
you’re not entirely at ease with beta releases, please do not use them! If, however, you don’t mind a bug
now and then, you can help me greatly by using the beta release and reporting any problems you may 
encounter.

New features
I need your input to keep CyberKit alive. Any bright ideas to make CyberKit better? Let me know! I 
promise I will consider all suggestions, however I reserve the right for the final decision. You can send 
new feature suggestions to Luc.Neijens@ping.be.

How to report a problem
Read the problem reports section.



Ping

What is ping?
Ping verifies a connection to a remote host by sending an ICMP (Internet Control Message Protocol) 
ECHO packet to the host and listening for an ECHO REPLY packet. The type of the ECHO REPLY packet
can be one of the following: 0 = normal echo reply, 3 = destination unreachable, 11 = TTL expired.
A message is always sent to an IP address. If you do not specify an address but a host name, this host 
name is resolved to an IP address using your default DNS server. In this case you’re vulnerable to a 
possible invalid entry on your DNS (Domain Name Server) server. You can simulate this resolving by 
using name server lookup and a search type of ‘Use Winsock Function GetHostByX’.
The host name that is displayed is obtained by resolving the originating IP address using your default 
DNS server.

To ping a host, do one of the following and press <enter> or select the Go button:
- Enter an address in the ‘Host or Address’ field. You can also copy the address from somewhere else 

and paste it in the ‘Host or Address’ field.
- Select an address from the drop down menu.
- Open the address book with F12 and double-click on the address to use.

To ping yourself, enter ‘me’ or ‘myself’ as host name.

You can set any of the following options:
- Timeout: the time, in seconds, CyberKit will wait for a response.
- Delay: the interval, in milliseconds, between pings.
- Packet Size: the size, in bytes, of a ping message.
- Number of Pings: the number of times you want to ping the host.
- Resolve IP Addresses: whether you want CyberKit to resolve the IP addresses for you. Unlike with 

traceroute this will not save you a lot of time, but it is there if you want to use it. If you choose to use it, 



you can always resolve the IP addresses later by double clicking on the sequence number for the host.

For each reply, you will see the following information:
- Number: The sequence number of the ping.
- Address: The IP address of the host that sent the ICMP echo reply.
- Host Name: The name of the host (only if you check ‘Resolve IP Addresses’).
- Msg Type: The type of the ICMP echo reply message.
- TTL: The value of the TTL field in the IP header of the ICMP echo reply.
- Time: The time in ms between the moment CyberKit sends the echo message to the remote host and 

the moment CyberKit receives the response.

Related topics: Traceroute, Name Server Lookup



Traceroute

What is traceroute?
Traceroute determines the route taken to a destination by sending ICMP (Internet Control Message 
Protocol) ECHO packets with varying TTL (Time To Live) values to the destination and listen for an ECHO
REPLY packet. The type of the ECHO REPLY packet can be one of the following: 0 = normal echo reply, 
3 = destination unreachable, 11 = TTL expired.
Each router along the path is required to decrement the TTL on a packet by at least 1 before forwarding it,
so the TTL is effectively a hop count. When the TTL on a packet reaches 0, the router is supposed to 
send back an ICMP Time Exceeded message to traceroute (type of the ICMP echo reply = 11).
Traceroute determines the route by sending the first echo packet with a TTL of 1 and incrementing the 
TTL by 1 on each subsequent transmission until a ICMP echo reply with type 0 is received, or the 
maximum TTL (=Maximum Hops) is reached. The route is determined by examining the ICMP Time 
Exceeded messages sent back by intermediate routers. Notice that some routers silently drop packets 
with expired time-to-live (TTL’s) and will be invisible to traceroute (you will get a ‘No response from this 
host’ entry).
The host name that is displayed is obtained by resolving the originating IP address for the ICMP echo 
reply message using your default DNS (Domain Name Server) server.

To trace the route to a host, do one of the following and press <enter> or select to Go button:
- Enter an address in the ‘Host or Address’ field. You can also copy the address from somewhere else 

and paste it in the ‘Host or Address’ field.
- Select an address from the drop down menu.
- Open the address book with F12 and double-click on the address to use.

You can set any of the following options:
- Timeout: the time, in seconds, CyberKit will wait for a response.
- Start From Hop: set this to ‘1’ if you want to start with the first hop. TIP: if for your ISP (Internet Service 



Provider) the first hop never responds, set this to ‘2’.
- Maximum Hops: the maximum number of hops to trace. In fact, this is the maximum value for TTL.
- Resolve IP Addresses: whether you want CyberKit to resolve the IP addresses for you. Unlike with ping 

this can speed things up considerably. If you choose to use this option, you can always resolve the IP 
addresses later by double clicking on the sequence number for the host.

For each host along the route, you will receive the following information:
- Number: The sequence number of the host in the Route.
- Address: The IP address of the host.
- Host Name: The name of the host.
- Msg Type: The type of the ICMP echo reply message.
- Time: The time between the moment CyberKit sends the echo message to the remote host and the 

moment CyberKit receives the response.

Related topics: Ping, Name Server Lookup



Finger

What is finger?
Finger allows you to obtain information about a user based upon his or her email address. Finger is 
typically supported by unix hosts.

To finger a person, or host, do one of the following and press <enter> or select the Go button:
- Enter an e-mail address in the ‘Host or Address’ or ‘Query’ field. You can also copy the address from 

somewhere else and paste it in one of the above fields.
- Enter a host name in the ‘Host or Address’ field.
- Select a host name or e-mail address from the drop down menu.
- Open the address book with F12 and double-click on the address to use.

You can set any of the following options:
- Clear Output: if you check this, the output will be cleared for each request.
- Verbose Format: some hosts will return more information if you check this field. A host that does not 

support this option is supposed to ignore it. Some hosts, however, will interpret this option as part of the 
user name and return an error message like "Illegal character in user name". If you encounter this 
problem, uncheck this field and try again.

To change the font select ‘Output Font’ from the Options Menu.



Whois

What is whois?
You can use whois to query a whois server (e.g. the InterNIC database) for names of companies, people, 
domain names, and IP address assignments. If you are querying an IP address you should limit your 
query to the first 3 parts for best results (use 125.58.65 and not 125.58.65.125).
There are many different parameters and keywords, that you can use in a whois query. Most servers will 
return a detailed description of the different types of query when you enter a ‘?’ or ‘HELP’ in the query 
field.
To obtain a recent list of whois servers use ‘WhoIs-Servers’ as query and ‘sipb.mit.edu’ as host.

To use whois, do one of the following and press <enter> or select the Go button:
- Enter an host name in the ‘Host or Address’ and a search string or command in the ‘Query’ field. You 

can also copy the information from somewhere else and paste it in one of the above fields.
- Enter a host name in the ‘Host or Address’ field.
- Select a host name or host name and command from the drop down menu.
- Open the address book with F12 and double-click on the address to use.

You can set any of the following options:
- Clear Output: if you check this, the output will be cleared for each request.

To change the font select ‘Output Font’ from the Options Menu.



Name Server Lookup

What is name server lookup?
With name server lookup you can resolve a host name into its TCP/IP addresses and vice versa. Any 
available aliases will also be reported.

To resolve a host name or TCP/IP address, do one of the following and press <enter> or select the 
Go button:
- Enter the address you want to resolve. You can use one of the following methods for this:

- Enter an address in the ‘Host or Address’ field. You can also copy the address from somewhere else 
and paste it in the ‘Host or Address’ field.

- Select an address from the drop down menu.
- Open the address book with F12 and double-click on the address to use.

- Specify the type of Search:
- Specify ‘Use Winsock Function GetHostByX’ to use the standard resolve function (this function is 

used by most applications, like your browser, email program etc. and the other client functions in 
CyberKit). This function always uses the default DNS server as specified in the network settings of 
your computer.

- You can also interrogate any other DNS server on the net for specific resource records. Just select 
the resource record in the ‘Type of Search’ field and enter the address or host name of the DNS 
server in the ‘Name Server’ field.

You can set any of the following options:
- Clear Output: if you check this, the output will be cleared for each request.
- Verbose Format: if you check this field, you will get a more detailed output.

To change the font select ‘Output Font’ from the Options Menu.



Related topics: Ping, Traceroute



Quote Of The Day

What is quote of the day?
Quote of the day will connect to a quote server and return a random quote (also known as cookie). Quote 
of the day is typically supported by NT servers.

To get the quote of the day, do one of the following and press <enter> or select the Go button:
- Enter an address in the ‘Host or Address’ field. You can also copy the address from somewhere else 

and paste it in the ‘Host or Address’ field.
- Select an address from the drop down menu.
- Open the address book with F12 and double-click on the address to use.

You can set any of the following options:
- Clear Output: if you check this, the output will be cleared for each request.

To change the font select ‘Output Font’ from the Options Menu.



Time

What is ‘time’?
With ‘time’ you can connect to a time server and see the difference in time between your PC’s clock and 
the time server. With the Time and SNTP protocol you can let CyberKit synchronize your PC clock. 

To get the time from a time server, do one of the following and press <enter> or select the Go 
button:
- Enter an address in the ‘Host or Address’ field. You can also copy the address from somewhere else 

and paste it in the ‘Host or Address’ field.
- Select an address from the drop down menu.
- Open the address book with F12 and double-click on the address to use.

You can set any of the following options:
- Protocol: select the protocol that CyberKit should use for this request. You can select Time, Daytime or 

SNTP.
- Synchronize local clock: if you check this, CyberKit will synchronize your local PC clock with the time 

server when you press the Go button. This option is only available for the Time and SNTP protocol.

To change the font select ‘Output Font’ from the Options Menu.

Is time displaying an incorrect local time or is the synchronize feature setting your system clock to an 
incorrect time? Have a look at the trouble shooting section for more help!

SNTP field descriptions (extracted from RFC2030)
Leap Indicator (LI): This is a two-bit code warning of an impending leap second to be inserted/deleted in 
the last minute of the current day, with bit 0 and bit 1, respectively, coded as follows:



            LIMeaning
            -------------------------------------------------------------------------
            0 no warning
            1 last minute has 61 seconds
            2 last minute has 59 seconds)
            3 alarm condition (clock not synchronized)

Version Number (VN): This is a three-bit integer indicating the NTP/SNTP version number. The version 
number is 3 for Version 3 (IPv4 only) and 4 for Version 4 (IPv4, IPv6 and OSI). If necessary to distinguish 
between IPv4, IPv6 and OSI, the encapsulating context must be inspected.

Mode: This is a three-bit integer indicating the mode, with values defined as follows:

            Mode Meaning
            -------------------------------------------------------------------------
            0 reserved
            1 symmetric active
            2 symmetric passive
            3 client
            4 server
            5 broadcast
            6 reserved for NTP control message
            7 reserved for private use

In unicast and anycast modes, the client sets this field to 3 (client) in the request and the server sets it to 
4 (server) in the reply. In multicast mode, the server sets this field to 5 (broadcast).

Stratum: This is a eight-bit unsigned integer indicating the stratum level of the local clock, with values 
defined as follows:

            Stratum Meaning
            -------------------------------------------------------------------------
            0 unspecified or unavailable
            1 primary reference (e.g., radio clock)
            2-15 secondary reference (via NTP or SNTP)
            16-255 reserved

Poll Interval: This is an eight-bit signed integer indicating the maximum interval between successive 
messages, in seconds to the nearest power of two. The values that can appear in this field presently 
range from 4 (16 s) to 14 (16284 s); however, most applications use only the sub-range 6 (64 s) to 10 
(1024 s).

Precision: This is an eight-bit signed integer indicating the precision of the local clock, in seconds to the 
nearest power of two. The values that normally appear in this field range from -6 for mains-frequency 
clocks to -20 for microsecond clocks found in some workstations.

Root Delay: This is a 32-bit signed fixed-point number indicating the total roundtrip delay to the primary 
reference source, in seconds with fraction point between bits 15 and 16. Note that this variable can take 
on both positive and negative values, depending on the relative time and frequency offsets. The values 
that normally appear in this field range from negative values of a few milliseconds to positive values of 
several hundred milliseconds.

Root Dispersion: This is a 32-bit unsigned fixed-point number indicating the nominal error relative to the 
primary reference source, in seconds with fraction point between bits 15 and 16. The values that normally



appear in this field range from 0 to several hundred milliseconds.

Reference Identifier: This is a 32-bit bitstring identifying the particular reference source. In the case of 
NTP Version 3 or Version 4 stratum-0 (unspecified) or stratum-1 (primary) servers, this is a four-character 
ASCII string, left justified and zero padded to 32 bits. In NTP Version 3 secondary servers, this is the 32-
bit IPv4 address of the reference source. In NTP Version 4 secondary servers, this is the low order 32 bits
of the latest transmit timestamp of the reference source. NTP primary (stratum 1) servers should set this 
field to a code identifying the external reference source according to the following list. If the external 
reference is one of those listed, the associated code should be used. Codes for sources not listed can be 
contrived as propriate.

            Code External Reference Source
            -------------------------------------------------------------------------
            LOCL Uncalibrated local clock used as a primary reference for a subnet without external means 

of synchronization
            PPS Atomic clock or other pulse-per-second source individually calibrated to national 

standards
            ACTS NIST dialup modem service
            USNO USNO modem service
            PTB PTB (Germany) modem service
            TDF Allouis (France) Radio 164 kHz
            DCF Mainflingen (Germany) Radio 77.5 kHz
            MSF Rugby (UK) Radio 60 kHz
            WWV Ft. Collins (US) Radio 2.5, 5, 10, 15, 20 MHz
            WWVB Boulder (US) Radio 60 kHz
            WWVH Kaui Hawaii (US) Radio 2.5, 5, 10, 15 MHz
            CHU Ottawa (Canada) Radio 3330, 7335, 14670 kHz
            LORC LORAN-C radionavigation system
            OMEG OMEGA radionavigation system
            GPS Global Positioning Service
            GOES Geostationary Orbit Environment Satellite



Winsock Database Scanner

What is winsock database scanner?
Winsock database scanner will scan your winsock database for available services and protocols. Absence
of this database can cause problems with winsock programs. You can use this function to verify whether it
is available.

You can set any of the following options:
- Scan Protocols: Scan de winsock database for all available protocols. The scan ranges from protocol 

number 1 through 255.
- Scan Services: Scan de winsock database for all available services. The scan can range from port 

(service) 1 through 65535. If you don’t want to scan this complete range (time consuming) you can 
specify a different range.



The Address Book

This address book can be used for any of the functions within CyberKit.
The address book is located in the CyberKit directory under the name CyberKit.pbk.
The default address book, also located in the CyberKit directory, is named CyberKit.def and is renamed to
CyberKit.pbk if CyberKit.pbk is not present. This procedure makes sure you retain your old address book 
when you install an update for CyberKit.

If you ever need to fall back on the default address book, take the following steps:
- Backup the CyberKit.pbk file and remove it afterwards
- If CyberKit.def is not present in the CyberKit directory: Re-install CyberKit. During installation choose for 

Custom Install. When prompted for the items to install, uncheck everything, except the address book.
- Restart CyberKit

Adding an address
Enter the new address in the ‘Add’ field and select the Add button.

Adding or changing notes for an address
Select the address you want to add the notes to, in the ‘Addresses’ list and enter your notes in the 
‘Notes’ field.

Removing an address
Select the address you want to remove, in the ‘Addresses’ list and select the Remove button.

Using an address
Double click on the address you want to use or select the address you want to use, in the ‘Addresses’ list
and select the Use button.

Getting help
Select the Help button.

Closing the address book
Select the Close button.



The Options Dialog

On the general options dialog you can configure the Keep Alive function, the firewalls, how you want 
CyberKit to behave if you minimize it and more.

On the mail options dialog you can customize the Check For New Mail function.

On the RAS options dialog you can customize the RAS settings.



The General Options Dialog

Remember Window Position
Check this if you want CyberKit to remember its window position. This way CyberKit will start where you 
last left it.

Remember Last Function
Check this if you want CyberKit to remember the last used function. This way CyberKit will start with the 
last used function.

Smart Address Splitting
Check this if you want CyberKit to automatically split addresses at the @ sign when entered in the finger 
or whois client. This is very useful when you paste email addresses in the host or query field. CyberKit will
also filter the host name out of an url (http://…) or ftp (ftp://…) address if you enable this option.

Minimize To Tray (not available on Windows NT 3.51 and lower)
Check this if you want CyberKit to minimize to the tray. CyberKit will add an icon to the tray and when you
minimize CyberKit, it will remove itself from the task bar. The icon will show a little lightning flash 
whenever CyberKit is doing something. The color of this lightning flash indicates what is happening:
Yellow: A client function is active (ping, traceroute, etc.)
Green: CyberKit is checking for new mail.
Blue: CyberKit is keeping your connection alive.
Red: CyberKit is dialing your connection.

If you left click on the tray icon, CyberKit will restore itself to its last position.



If you right click on the tray icon, you will get a popup menu from which you can choose a function like: 
restore to ping, Check for Mail, etc. Also you can dial your dialup connections from here.

Finger Firewall
If you have to use a firewall for finger, enter it here.

Whois Firewall
If you have to use a firewall for whois, enter it here.

Send KeepAlive Messages
Check this if you want CyberKit to keep your connection alive. The second light above the ‘Go’ button 
indicates the status of this function.

Send every x minutes
Specify the interval between keep alive messages.

Use host
Specify the host to connect to. CyberKit will ping this host periodically. If you leave this field blank, keep 
alive will not work.

Create a trace file
If you check this CyberKit will create a small log file in the CyberKit directory. The name of the log file is 
KeepAlve.log. You can use any editor to view this log file. This can be very useful to track down problems 
with this function.

Related topics: the mail options dialog, the RAS options dialog



The Mail Options Dialog

Check For New Mail
Check this if you want CyberKit to check for new mail. At this time only the POP3 protocol is supported. 
Check with your system administrator for more information about the POP3 protocol. The third light above
the ‘Go’ button indicates the status of this function.

Check Every x Minutes
Specify how often CyberKit has to check for new mail.

Check at startup
Check this if you want CyberKit to check for new mail when you start it.

E-Mail Reader
If you enter the full path and filename for your E-mail reader here, a left click on the new mail icon in the 
tray will launch your E-mail reader. If the path or filename of your E-mail reader contains spaces, you’ll 
have to enclose it with double quotes. Any command line parameters must be separated by a space and 
located outside the quotes.
If you’re an Internet Mail user, try this: "C:\WINDOWS\EXPLORER.EXE" /root,C:\WINDOWS\Internet 
Mail.{89292102-4755-11cf-9DC2-00AA006C2B84}

POP Host
Enter your POP3 host here.

Username
Enter your POP3 user id here.



Password
Enter your POP3 password here.

Create a trace file
If you check this CyberKit will create a small log file in the CyberKit directory. The name of the log file is 
Mail.log. You can use any editor to view this log file. This can be very useful to track down problems with 
this function.

Only Notify Once
If you enable this option, CyberKit will only notify you once of new mail. The number of messages for the 
tray icon will still be updated.

Play a sound
Enter any .wav file you want. If you don’t specify any .wav file, CyberKit will use the default PC-speaker 
beep.

Add an icon to the tray (not available on Windows NT 3.51 and lower)
CyberKit will add an icon to the Tray when there is mail waiting for you. If you provide the name of your E-
Mail reader, a left click on this icon will launch your E-mail reader for you.

Use an alert dialog box
CyberKit will pop up a dialog box when there is mail waiting for you.

Remarks:
- This function will not work correctly if you leave your mail on the server.
- CyberKit will NOT notify you of new mail in the following cases:

1) The number of messages AND the size of these messages have not changed since the last check.
2) The number of messages has grown since the last check and you have the ‘Only Notify Once’ option

enabled (this does not apply if the number of messages in the last check was zero).

Related topics: the general options dialog, the RAS options dialog



The RAS Options Dialog

Don’t dial for ‘Keep Alive’ and ‘Check For New Mail
If you set the ‘Keep Alive’ or ‘Check For New Mail’ option, CyberKit will periodically connect to your ISP. 
If you’re not connected, CyberKit will connect for you. If you don’t want CyberKit to dial the connection for
you, check this option. This way, CyberKit will only use the ‘Keep Alive’ or ‘Check For New Mail’ function 
when the specified dialup connection is already active.

DialUp Connection
Specify the required dialup connection for ‘Keep Alive’ and ‘Check For New Mail’. If you select the ‘Don’t
dial …’ option, CyberKit will only perform the above functions when this dialup connection is active. If you 
select ‘Any Connection’, any active connection will suffice.

Related topics: the general options dialog, the mail options dialog



More Information (RFC’s)

This help file is a user guide for CyberKit. If you need more specific information about TCP/IP or one of 
the services (e.g. ping, finger,    …) you will need to find some other resources. Probable the best 
resource out there is the Internet. With the help of a search engine you’ll be able to find all the information
you will ever need! You can use the following information as a starting point.

The RFC’s (Request For Comments) contain the specifications for Internet services like finger, whois, etc.
They are ideal for those who want to program their own services or those who want to know the finer 
details. A search for ‘RFC’ in a search engine will provide you with lots of sites where you can read the 
RFC’s text files. Here are a few to start with:
- RFC 1885: The Internet Control Message Protocol (ICMP)
- RFC 1288: The Finger User Information Protocol
- RFC 1035: Domain Names (NS LookUp)
- RFC 1939: The Post Office Protocol Version 3 (POP3)
- RFC 865: The Quote of Day Protocol
- RFC 867: The Daytime Protocol
- RFC 868: The Time Protocol
- RFC 1305: The Network Time Protocol (NTP)
- RFC 2030: The Simple Network Time Protocol (SNTP)



The Command Line Parameters

To enter command line parameters:
- Right click on the CyberKit icon
- Select properties
- Append the command line parameters to the target field.
For example, suppose you want to start CyberKit with the ping tab and minimized to the tray:
If CyberKit is located in the C:\Program Files\CyberKit folder you should enter the following in the target 
field:
“C:\Program Files\CyberKit\CyberKit.exe” -M -P

You can use the following command line parameters with CyberKit. Not all sub parameters are required, 
but if you use them you must enter them in the order in which they are described.

-M
This will start CyberKit minimized as a Tray Icon. Not available on Windows NT 3.51 and lower.

-P   ‘  address  ’   Txx Dxx Pxx Nxx RESOLVE  
-P: Start CyberKit with the ping tab.
‘address’: The host name or IP address to ping.
Txx: Timeout value (in seconds).
Dxx: Delay value (in milliseconds).
Pxx: Packet size.
Nxx: Number of pings.
RESOLVE: Resolve IP addresses.
Examples:
-P
-P www.ping.be
-P www.ping.be T5 D600 P64 N5 RESOLVE

-T   ‘  address  ’   Txx Sxx Exx RESOLVE  
-T: Start CyberKit with the traceroute tab.
‘address’: The host name or IP address to trace.
Txx: Timeout value (in seconds).
Sxx: Starting hop number.
Exx: Ending hop number.
RESOLVE: Resolve IP addresses.
Examples:
-T
-T www.ping.be
-T www.ping.be T5 S1 E30 RESOLVE

-F   ‘  address  ’     ‘  query  ’   VERBOSE  
-F: Start CyberKit with the finger tab.
‘address’: The host name or IP address to query.
‘query’: The query.
VERBOSE: Use verbose option.
Examples:
-F
-F l.gp.cs.cmu.edu coke
-F l.gp.cs.cmu.edu coke VERBOSE

-W   ‘  address  ’     ‘  query  ’  
-W: Start CyberKit with the whois tab.



‘address’: The host name or IP address to query.
‘query’: The query.
Examples:
-W
-W whois.internic.net help

-N   ‘  address  ’     ‘  nameserver  ’     ‘  type  ’   VERBOSE  
-N: Start CyberKit with the name server lookup tab.
‘address’: The host name or IP address you want to resolve.
‘nameserver’: The name server CyberKit should use. This parameter is mandatory if you use the ‘type’ 
parameter.
‘type’: Can be any of the search types, e.g. A, HINFO, … This parameter is mandatory if you use the 
‘nameserver’ parameter.
VERBOSE: Use verbose option.
Examples:
-N
-N www.ping.be (this uses the winsock function GetHostByX).
-N ping.be rs.internic.net ALL VERBOSE.

-Q   ‘  address  ’  
-Q: Start CyberKit with the quote of the day tab.
‘address’: The host name or IP address you want to query for a quote.
Examples:
-Q
-Q www.engen.com

-t   ‘  address  ’     ‘  protocol  ’   SYNC QUIT  
-t: Start CyberKit with the time tab.
‘address’: The host name or IP address of the time server.
‘protocol’: The protocol to use, this can be TIME, DAYTIME or SNTP.
QUIT: Quit CyberKit as soon as this query is finished.
Examples:
-t
-t timehost.com DAYTIME
-M -t timehost.com SNTP SYNC QUIT



The CyberKit Menu

There are four available menus:

The File Menu:
Dial …: Submenu that contains your dial-up connections. Select the connection that you want to dial. If 
you have more than 10 dial-up connections, this menu item will open a dialog box containing all your dial-
up connections.
Save: Saves the information on the page to a file.
Copy results to Clipboard: Copies the information on the page to the clipboard for use outside CyberKit.
Print: Prints the information on the page.
Check for Mail: Checks whether there is new mail waiting for you.
Clear Recent List: Choose this menu item to clear the recent list of the active function.
Exit: Close the CyberKit program

The Options Menu:
Settings: Choose this menu item to activate the Options Dialog.
Output Font: Choose this menu item to change the Output Font.

The View Menu:
Winsock Information: Select this menu item to see your the socket release you are using.
Addressbook: Choose this menu item to activate the Addressbook

The Help Menu:
Contents: Select this menu item to see the help contents.
Help on Help: Select this menu item to see the windows help file about how to use help.
Go Online and …:

- Visit CyberKit Homepage: This will start your Web Browser and point it to the CyberKit HomePage. 
Use this to go online and check for new releases, bug reports, etc.

- Give Feedback: This will start your e-mail program so you can send me a message with your 
feedback information.

About CyberKit: Select this menu item to see the about box.




